
Experiment 38: Interference of Stimuli on 
Associative Tasks - The Stroop Effect

Background
In his doctoral thesis published in 1935, J.R. Stroop 

reported that the completion of a task could be strongly 
influenced by stimuli from another task to which it is 
associated. In his work, Stroop found that a subject’s 
ability to read words was influenced by the color in 
which the words were printed. Likewise, the subject’s 
ability to name the colors in which the words were 
printed was influenced by the actual words. Each task, 
naming colors and reading words, received inter-
ference from stimuli associated with the other task. 

Stroop conducted tests in which subjects were asked 
to read words that identify specific colors, however, the 
words were printed in a color that was different than 
the color identified by the word. For example, when the 
word “Green” was printed with blue ink, the subject 
was asked to read the word “Green”. When compared 
to the control task of reading color words printed in 
black, the increase in the time taken by the subject to 
react to words printed in conflicting colors was an 
indication of the interference of color stimuli on the 
task of reading words. Stroop also proposed the 
strength of the interference was an indication of the 
strength of the association between the two tasks.

In another test, subjects were asked to name the 
conflicting color in which the color word was printed. 
For example, the word “Red” was printed in green and 
the subject was asked to name the color “Green”. 
When compared to the control task of naming the 
colors in which the same nondescript symbol was 
printed, the increase in the time taken by the subject to 
react to the colors of conflicting words was an 
indication of the interference of word stimuli on the 
task of naming colors. Go to the fourth column on 
Table 8-3 on page 7 and name the colors in which the 
words are printed. It’s not that easy, is it? Through 
your experience, you have been taught that the 
meaning of a word is more important than the color in 
which it is printed. When you try to pay attention to a 
color and name it, the word stimuli interferes with the 
task.

In this experiment, subjects will perform tasks that 
demonstrate the Stroop Effect in several different 
ways: the effect of word stimuli on color naming, the 
effect of color stimuli on reading words, the effect of 
word stimuli on naming directions, and stimuli of your 
own choice or design. The completion time of each 
task will be used as an indicator of the strength of the 

interference of the stimuli on the task; Stroop corre-
lated longer completion times to higher degrees of 
interference. 

Since these tasks are also stressors, the heart rate 
and skin conductance level of each subject will be 
recorded before, during, and after each task (Figure 8-
1 on page 1). Do you think the stress indicators will 
correlate to the level of interference during a task?

 Figure 8-1: Heart rate (HR), pulse, and skin conductance level (SCL) of 
subject performing the task of naming the colors of symbols printed in a 
list. From 6 seconds before the beginning of the task to 6 seconds after the 
completion of the task, the subject’s heart rate increases by 40% and SCL 
increases by 50%.

Equipment Required
PC Computer

iWorx unit, and USB or serial cable

PT-104 Pulse plethysmograph

GSR-100/200 GSR amplifier, electrodes, and 
extension cable

Tables of words and symbols

Equipment Setup
1 Connect the iWorx unit to the computer (described in 

Chapter 1).

2 Select a person from your group to be the subject. 

3 Locate the DIN connector on the end of the plethysmo-
graph cable and plug it into Channel 3 (Figure 8-2 on 
page 2). 

4 Place the plethysmograph on the volar surface (where the 
fingerprints are located) of the distal segment of the 
middle finger, and wrap the Velcro strap around the end of 
the finger to attach the unit firmly in place.

5 Plug one end of a male DIN-male DIN cable into the GSR 
amplifier. Connect the other end of the same cable to 
Channel 4 (Figure 8-2 on page 2). 
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6 Pull down the Window menu on the LabScribe Main 
window and select Preview. Click the arrows at the top of 
Preview window to select the on-line display of the GSR 
channel (CH 4). Use the offset knob on the GSR amplifier to 
move the observed output to zero. Click the OK button on 
the Preview window.

7 The GSR-200 amplifier is factory calibrated so that an 
output of 1 Volt is equal to 5 microSiemens (µS).

8 To enter this conversion factor into the recording settings, 
pull down the Edit menu in the Main window, and select 
Preferences and go to the Channels window.

9 Under the Calibration section of the Channels window, the 
following settings should be used:

Calibration 

Raw  Cal Unit
1 =>  5 µS
0 => 0

These settings mean that 1 Volt (raw unit) is set equal 
to 5 µS (calibrated unit), and 0 Volt is set equal to 0 µS.

10 Connect the GSR electrodes to the BNC connector on the 
GSR amplifier. 

11 Attach the GSR electrodes to the volar surface of the distal 
finger segment of the subject’s index finger and ring finger. 
Attach the electrodes with the Velcro straps so that the 
straps are snug, but not overly tight.

 Figure 8-2: The equipment needed to record heart rate and skin conductance.

Start the Software
1 Click the Windows Start menu, move the cursor to 

Programs and then to the iWorx folder and select 
LabScribe; or click on the LabScribe icon on the Desktop.

2 When the program opens, select Load Group from the 
Settings menu.   

3 When the dialog box appears, select AddedLabs.iws. Click 
Load.

4 Click on the Settings menu again and select the Stroop-
Effect settings file.

5 After a short time, LabScribe will appear on the computer 
screen as configured by the StroopEffect settings.

Exercise 1: Interference of Color Stimuli on 
Reading.

Aim: To determine the effect of the color in which a 
word is printed on the subject’s ability to read the word.

Procedure

1 Ask the subject to sit quietly at a table, out of view of the 
computer monitor, and in a position to read from Table 8-3 
on page 7. The subject should rest the hand with the 
electrodes comfortably on his or her lap.

2 Click Start. Click AutoScale on the Pulse channel to 
optimize the size of the pulse signal. This will permit the 
heart rate displayed on Channel 2 (Heart Rate) to be calcu-
lated accurately. 

3 Type the subject’s first name and the words “Task 1: Read 
Words in Black” on the comment line to the right of the Mark 
button. Record until the skin conductance level of the 
subject, recorded on Channel 4 (GSR-SCL), has reached a 
stabile baseline.

4 Instruct the subject to read aloud, as quickly as possible, 
the words in the first column of Table 8-3 on page 7. Press 
the Enter key on the keyboard as soon as the subject 
begins reading the list. Quickly type the word “End” on the 
comment line.

5 Press the Enter key on the keyboard as soon as the subject 
has read the last word in the first column. Continue to 
record.

6 Type the words “Task 2: Read Words in Conflicting Colors” 
on the comment line, as the subject relaxes for 1 to 2 
minutes.

7 Instruct the subject to read aloud, as quickly as possible, 
the words in the second column of Table 8-3 on page 7. 
Press the Enter key on the keyboard as soon as the subject 
begins reading the list. Quickly type the word “End” on the 
comment line.

8 Press the Enter key on the keyboard as soon as the subject 
has read the last word in the second column. Continue to 
record as the subject relaxes for a minute. 

9 Begin Exercise 2 at the end of a 1 to 2 minute relaxation 
period.

Exercise 2: Interference of Word Stimuli on 
Naming.

Aim: To determine the effect of words on the subject’s 
ability to name the colors in which the words are printed.

Procedure

1 Type the words “Task 3: Name Color of Symbols” on the 
comment line, as the subject is relaxing. 
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2 Instruct the subject name aloud, as quickly as possible, the 
colors in which the symbols in the third column of Table 8-3 
on page 7. Press the Enter key on the keyboard as soon as 
the subject begins naming the colors in the list. Quickly type 
the word “End” on the comment line.

3 Press the Enter key on the keyboard as soon as the subject 
has named the color of the last symbol in the third column. 
Continue to record.

4 Type the words “Task 4: Name Color of Conflicting Words” 
on the comment line, as the subject relaxes for 1 to 2 
minutes.

5 Instruct the subject to name aloud, as quickly as possible, 
the colors in which the words in the fourth column of 
Table 8-3 on page 7. Press the Enter key on the keyboard 
as soon as the subject begins naming the colors in the list. 
Quickly type the word “End” on the comment line.

6 Press the Enter key on the keyboard as soon as the subject 
has named the color of the last word in the fourth column. 

7 Continue to record for 1 to 2 minutes.

8 Click Stop to halt the recording. 

9 Select Save As in the File menu, type a name for the file. 
Choose a destination on the computer in which to save the 
file(e.g. the iWorx or class folder). Click the Save button to 
save the file (as an *.iwd file).

Analysis-Skin Conductance Level (SCL) & Heart Rate

1 Go to the segment of the recording that is before Task 1. 

2 Use the Display Time icons on the LabScribe toolbar 
(Figure 8-3 on page 3) to adjust the time displayed on the 
Main window, so that the segment before Task 1 can be 
viewed on the screen.

3 Click the 2-Cursor icon (Figure 8-3 on page 3) so that two 
blue vertical lines appear on the Main window. Use the 
cursors to select the complete segment before Task 1.

 Figure 8-3: The LabScribe toolbar

4 Click the Analysis icon (Figure 8-3 on page 3) to open the 
Analysis window.

5 Display the Heart Rate and GSR-SCL channels (Channels 
2 and 4) in the Analysis window by selecting them from the 
Display Channels menu on the left side of the Analysis 
window (Figure 8-4 on page 3). Use the Windows Control-
Click function to make the selection.

6 Use the mouse to click and drag a cursor to each edge of 
the Analysis window. Select Title, Max, Min, Mean, and 
Max-Min from the Table Functions list and GSR-SCL from 
the Value from Channel menu. The values displayed in the 
table across the top of the Analysis window will be the 

subject’s skin conductance level values for this segment.

7 Enter data into the Journal by either typing the titles and 
values directly or by using the right-click menu. Place the 
cursors to take measurements; then, select Add Title to 
Journal or Add Data to Journal from the right-click menu 
to add the measurements to the Journal.

 Figure 8-4: Heart rate (HR) and skin conductance level (SCL) data for Task 3 
(Naming Colors of Symbols), as displayed in the Analysis window. The subject 
took 11.830 seconds to complete this task. During the task, the subject’s SCL 
rose 43.3%, from 0.829 to 1.188 uSiemens.

8 Select Heart Rate from the Value from Channel menu. 
The values displayed in the table across the top of the 
Analysis window will be the subject’s heart rate values for 
this segment.

9 Enter this data into the Journal using the same techniques 
used in Step 7. Put a notation in the Journal that these 
values are from the segment before Task 1.

10 Click Save in the File menu to save the contents of the 
Journal.

 Figure 8-5: Heart rate (HR) and skin conductance level (SCL) data for Task 
4(Naming Colors of Words), as displayed in the Analysis window. The subject 
took 23.904 seconds to complete this task. During the task, the subject’s SCL 
rose 68.3%, from 0.928 to 1.562 uSiemens.
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11 Repeat Steps 1 through 10 of this analysis for the other 
segments in Exercises 1 and 2: 

• Task 1,

• Time between Tasks 1 and 2, 

• Task 2,

• Time between Task 2 and 3, 

• Task 3 (Figure 8-4 on page 3),

• Time between Tasks 3 and 4,

• Task 4 (Figure 8-5 on page 3),

• Time after Task 4.

12 Enter the subject’s data into Table 8-1 on page 4.

Analysis-Task Completion Times and Differentials

1 Go to the recording of Task 1. 

2 Use the Display Time icons on the LabScribe toolbar 
(Figure 8-3 on page 3) to adjust the time displayed on the 
Main window, so that the marks that define the beginning 
and end of Task 1 can be viewed on the screen.

3 Click the 2-Cursor icon (Figure 8-3 on page 3) so that two 
blue vertical lines appear on the Main window. Place the 
cursors on the marks at the beginning and end of Task 1.

4 Read the time difference (T2-T1) between the positions of 
the two cursors from the upper left corner of the Main 
window. The value for T2-T1 is the time taken by the subject 
to complete the task.

5 Record the completion time for this task in the Journal by 
typing it directly into that window.

6 Click Save in the File menu to save the contents of the 
Journal.

7 Repeat Steps 1 through 6 for Tasks 2, 3, and 4 in this 
exercise.

8 Enter the completion times into Table 8-1 on page 4.

9 Determine the differences between the completion times of 
Task 2 and Task 1, and Task 4 and Task 3. Report these 
values in Table 8-1 on page 4.

Questions

1 Is there a difference between the changes in the subject’s 
skin conductance level (SCL) in Tasks 1 and 2? Is there a 
difference between the subject’s heart rate in Tasks 1 and 
2? 

2 Did the subject take longer to complete Task 1 or Task 2? 
Did the color stimuli interfere with reading words?

3 Is there a difference between the changes in the subject’s 
skin conductance level (SCL) in Tasks 3 and 4? Is there a 
difference between the subject’s heart rate in Tasks 3 and 
4? 

4 Did the subject take longer to complete Task 3 or Task 4? 
Did the word stimuli interfere with naming colors?

5 Did the subject take longer to complete Task 2 or Task 4? 
Did the word stimuli make color naming more difficult or did 
the color stimuli make reading words more difficult? Why is 
this so?

Predictions

1 What would happen if the order of the colors in the list of 
words for Task 2 (Reading Colored Words) was repetitive?

2 What would happen if the order of the colors in the list for 
Task 3 (Naming Colors of Symbols) was repetitive?

3 What would happen if the order of the colors in the list of 
words for Task 4 (Naming Colors of Words) was repetitive?

4 What would happen in Task 4 if the subject was a child who 
had not yet learned to read?

5 What would happen in Task 4 if the subject was just 
beginning to speak English?

Table 8-1: Skin conductance levels,  heart rates,  and complet ion times during Tasks 1 through 4.

Skin Conductance (µS) Heart  Rate (BPM) Times (secs)

Task Max Min Mean Max-
Min Max Min Mean Max-

Min
Complet ion 

of  Task Different ia l

Before Task 1

Task 1:  Read in  Black Pr int

Between Tasks 1 and 2

Task 2:  Read in  Different  Color

Between Tasks 2 and 3

Task 3:  Name Color of  Symbol

Between Tasks 3 and 4

Task 4:  Name Color of  Word

After Task 4 
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Exercise 3: Interference of Word Stimuli on 
Determining Direction

Aim: To determine the effect of words on the subject’s 
ability to name the location of a word in a frame.

Procedure

1 Ask the subject to sit quietly at a table, out of view of the 
computer monitor, and in a position to examine Table 8-4 on 
page 8. The subject should rest the hand with the 
electrodes comfortably on his or her lap.

2 Click Start. Click AutoScale on the Pulse channel to 
optimize the size of the pulse signal. This will permit the 
heart rate displayed on Channel 2 (Heart Rate) to be calcu-
lated accurately. 

3 Type the subject’s first name and the words “Task 5: Name 
Position of Same Word” on the comment line to the right of 
the Mark button. Record until the skin conductance level of 
the subject, recorded on Channel 4 (GSR-SCL), has 
reached a stabile baseline.

4 Instruct the subject to name the position of the word in each 
frame on Table 8-4 on page 8 aloud, as quickly as possible. 
Press the Enter key on the keyboard as soon as the subject 
begins naming the position of the word. Quickly type the 
word “End” on the comment line.

5 Press the Enter key on the keyboard as soon as the subject 
has named the last position on Table 3. Continue to record.

6 Type the words “Task 6: Name Position of Different Words” 
on the comment line, as the subject relaxes for 1 to 2 
minutes.

7 Instruct the subject to name the position of the word in each 
frame on Table 8-5 on page 9 aloud, as quickly as possible. 
Press the Enter key on the keyboard as soon as the subject 
begins naming the position of the word. Quickly type the 
word “End” on the comment line.

8 Press the Enter key on the keyboard as soon as the subject 
has named the last position on Table 4. Continue to record 
as the subject relaxes for 1 to 2 minutes.

Analysis-Skin Conductance Level (SCL) & Heart Rate

1 Go to the segment of the recording that is before Task 5. 

2 Use the Display Time icons on the LabScribe toolbar 
(Figure 8-3 on page 3) to adjust the time displayed on the 
Main window, so that the segment before Task 5 can be 
viewed on the screen.

3 Click the 2-Cursor icon (Figure 8-3 on page 3) so that two 
blue vertical lines appear on the Main window. Use the 
cursors to select the complete segment before Task 5.

4 Click the Analysis icon (Figure 8-3 on page 3) to open the 
Analysis window.

5 Display the Heart Rate and GSR-SCL channels (Channels 
2 and 4) in the Analysis window by selecting them from the 
Display Channels menu on the left side of the Analysis 
window. Use the Windows Control-Click function to make 

the selection.

6 Use the mouse to click and drag a cursor to each edge of 
the Analysis window. Select Title, Max, Min, Mean, and 
Max-Min from the Table Functions list and GSR-SCL from 
the Value from Channel menu. The values displayed in the 
table across the top of the Analysis window will be the 
subject’s skin conductance level values for this segment.

7 Enter data into the Journal by either typing the titles and 
values directly or by using the right-click menu. Place the 
cursors to take measurements; then, select Add Title to 
Journal or Add Data to Journal from the right-click menu 
to add the measurements to the Journal.

8 Select Heart Rate from the Value from Channel menu. 
The values displayed in the table across the top of the 
Analysis window will be the subject’s heart rate values for 
this segment.

9 Enter this data into the Journal using the same techniques 
used in Step 7. Put a notation in the Journal that these 
values are from the segment before Task 5.

10 Click Save in the File menu to save the contents of the 
Journal.

11 Repeat Steps 1 through 10 of this analysis for the other 
segments in Exercise 3: 

• Task 5,

• Time between Tasks 5 and 6,

• Task 6,

• Time after Task 6.

12 Enter the subject’s data into Table 8-2 on page 6.

Analysis-Task Completion Times and Differentials

1 Go to the recording of Task 5. 

2 Use the Display Time icons on the LabScribe toolbar 
(Figure 8-3 on page 3) to adjust the time displayed on the 
Main window, so that the marks that define the beginning 
and end of Task 5 can be viewed on the screen.

3 Click the 2-Cursor icon (Figure 8-3 on page 3) so that two 
blue vertical lines appear on the Main window. Place the 
cursors on the marks at the beginning and end of Task 5.

4 Read the time difference (T2-T1) between the positions of 
the two cursors from the upper left corner of the Main 
window. The value for T2-T1 is the time taken by the subject 
to complete the task.

5 Record the completion time for this task in the Journal by 
typing it directly into that window.

6 Click Save in the File menu to save the contents of the 
Journal.

7 Repeat Steps 1 through 6 for Task 6.

8 Enter the completion times into Table 8-2 on page 6.

9 Determine the differences between the times of Task 6 and 
Task 5. Report these values in Table 8-2 on page 6. 
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Questions

1 Is there a difference between the changes in the subject’s 
skin conductance level (SCL) in Tasks 5 and 6? Is there a 
difference between the subject’s heart rate in Tasks 5 and 
6? 

2 Did the subject take longer to complete Task 5 or Task 6? 
Did the word stimuli interfere with naming directions?

Exercise 4: Additional interferences
Aim: To perform another test for interference between 

associative tasks.

Procedure

1 Find or devise an additional test for interference between 
tasks that seem to be associated. 

• Additional tests to demonstrate the “Stroop Effect” can be 
found by searching the Internet. You should be able to find 
tests that demonstrate other interferences: word stimuli on 
counting, word stimuli on naming pictures, and audio stimuli on 
naming. 

• Devise your own test on tasks that think are associated.

• Test one of the predictions made earlier in this experiment.

2 Record the same parameters, skin conductance level and 
heart rate and test completion time, used in Exercises 1, 2, 
and 3.

Analysis

1 Use the same methods employed in Exercises 1, 2, and 3 to 
analyze the data collected from this additional Stroop test.

2 Construct a table to display the results of your test. Share 
these results with other groups in your class.

3 Compare the strength of interference of this additional 
stimuli to the strength of interference of the additional stimuli 
used by other groups of students.

4 Compare the strength of interference of this additional 
stimuli to the strengths of interference demonstrated in 
Exercises 1, 2, and 3.

Table 8-2: Skin conductance levels,  heart rates,  and complet ion times during Tasks 5 and 6.

Skin Conductance (µS) Heart  Rate (BPM) Times (secs)

Task Max Min Mean Max-
Min Max Min Mean Max-

Min
Complet ion 

of  Task Different ia l

Before Task 5

Task 5:  Name Same Direct ion

Between Tasks 5 and 6

Task 6:  Name Different  Direct ion

After Task 6
Chapter 8: 6



Table 8-3: Lists of colored words used in Exercises 1 and 2 of Experiment 38:  The Stroop Effect.

Task1 Task 2 Task 3 Task 4

BLUE BLUE XXXX RED

GREEN GREEN XXXX BLUE

RED BLACK XXXX GREEN

GREEN BLUE XXXX BLUE

RED GREEN XXXX BLACK

RED RED XXXX BLUE

BLUE GREEN XXXX GREEN

GREEN RED XXXX RED

BLUE BLUE XXXX GREEN

BLACK BLACK XXXX RED

BLUE BLUE XXXX BLUE

BLACK GREEN XXXX BLACK

BLUE RED XXXX BLUE

GREEN BLUE XXXX GREEN

BLUE GREEN XXXX BLACK

GREEN BLUE XXXX BLUE

BLACK BLACK XXXX RED

BLUE BLUE XXXX GREEN

GREEN BLACK XXXX RED

RED BLUE XXXX BLUE

BLACK RED XXXX GREEN

BLUE GREEN XXXX BLACK

RED RED XXXX BLUE

GREEN GREEN XXXX GREEN

RED RED XXXX RED
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Table 8-4: Frames with identical words and positions used in Exercise 3 of Experiment 38.

UP

LEFT

DOWN

LEFT RIGHT

LEFT

UP

RIGHT

DOWN

UP

UP

DOWN

RIGHT

UP

LEFT

DOWN

LEFT

UP

RIGHT

DOWN

LEFT RIGHT

DOWN

UP

RIGHT
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Table 8-5: Frames with dif ferent words and posit ions used in Exercise 3 of  Experiment 38.

UP

LEFT

DOWN

LEFT

RIGHT 

LEFT UP

RIGHT DOWN UP

UP

DOWN

RIGHT

UP

LEFT

DOWN LEFT UP

RIGHT

DOWN

LEFT

RIGHT

DOWN UP RIGHT
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